
Creating a Web Site to Gather Data and Conduct Research

Introduction

Microsoft® FrontPage® 2002 is a tool that students, teachers and administrators can use to design a useful, detailed Web site without needing to know any Web design or programming. You need only choose how you want your Web site to look and what information to include, and FrontPage can do the rest. You can create many different types of Web pages, from class information pages to e-commerce pages for a fundraiser, and everything in between.

FrontPage 2002 is also a useful research tool for the classroom. In addition to using the Web to find information from other sources, you can use it to obtain information from visitors to your Web site. For example, you can use FrontPage 2002 or SharePoint Team Services to create a Web site that collects information about any topic your class is studying, and you then choose how to save, present, and interact with the information you collect. SharePoint Team Services from Microsoft is an instant Web solution available with FrontPage 2002. It is designed to improve the way you manage information and activities, both in and out of the classroom. Your Web site becomes the central location for all project information, such as assignments, student and faculty contact information, tasks, upcoming forums, and more. This tutorial discusses how to add research and data gathering elements to a Web site by using FrontPage and SharePoint Team Services. 

Note   Before completing this tutorial, you should have already created a Web site by using FrontPage. If you do not have a Web site or need additional information, see the tutorial "Creating a Course Web Site" at http://www.microsoft.com/education/?ID=FrontPageTutorial.

Some additional FrontPage 2002 features that are discussed in this tutorial include:  

· SharePoint Team Services surveys. Develop and customize a survey that can be accessed easily by each member of the SharePoint Team Services Web site. Monitor and review all responses, and view a graphical representation of the data.

· Database Results Wizard. Display information from a database on a Web page for others to view.
· Database Interface Wizard. Use this tool to integrate database information into a Web page. You can create a new database to store information or connect to an existing database without having to install another application, such as Microsoft Access.

Another powerful feature of FrontPage 2002 is creating a record of threaded discussions by using the Discussion Web. This is done by using the SharePoint Team Services tool. Students can hold discussions from any location, and then use the Discussion Web to organize the discussions according to topic. The threaded discussion can then serve as reference for study groups, research papers, or presentations.

Touring FrontPage
Before you begin using FrontPage, you should familiarize yourself with the layout and features. The following illustration shows the Navigation view: 



Adding functionality to a FrontPage Web site

FrontPage 2002 is a powerful tool for creating Web sites for almost any purpose. With an extensive array of wizards, templates and step-by-step instructions, you can create a Web site that can help students and educators gather and share information with ease. You can do this by creating forms, conducting surveys, connecting your site to a database, or by displaying the contents of a database on the site.

Using FrontPage wizards

When you use a wizard to create a Web site, you must decide which wizard best suits your purposes. The Database Interface Wizard provides students and teachers access to the information in a database. The Discussion Web Wizard provides students, teachers, or others with a place to post their comments about a subject, project, or debate in a threaded discussion format. This is useful for student collaboration, for example. The Import Web Wizard enables students and teachers to use an existing Web site as a foundation for an entirely new Web site.

Using the Database Interface Wizard

The Database Interface Wizard enables you to tap into the power of connecting a database into a Web site. You can perform any database task, such as adding or modifying database records or simply displaying database information, all from your Web site. You can also add form information that you collect on your Web site, such as student evaluations or assignments, into your database.

The Database Interface Wizard, which is accessed through the New page or Web task pane under Web Templates, can be used to connect to an existing database so that students or teachers can gather and manipulate data without installing Microsoft Access or another database program on their computers. It consolidates complex and extensive research results and simplifies access to the information, making it easier than ever to work with database content.

Suppose you wanted to compile data for Developmental Psychology students in a central location. The research data might include a variety of subjects, such as child development issues, adolescent behavioral patterns, or societal perceptions of the elderly. By using the Database Interface Wizard, students can access the specific database information they need directly from their computers. They can then create new Web pages to display their findings in any format they want, such as a graph or table, or use links to direct fellow students to other relevant Web sites. The Web site provides a library of information that students can use for group discussions, completing assignments, or research papers. 

In this example, students will use the Database Interface Wizard to view and give other students access to a database that contains information pertaining to studies done about the elderly in today's society. As an online repository of information, the database enables students to look up any information pertaining to the research, such as the demographics, income levels, or ages of the subjects. 

To generate a form by using the Database Interface Wizard

1. On the File menu, point to New, and then click Page or Web.

2. On the New page or web task pane, click Web Site Templates.

3. In the Web Templates dialog box, type the location where you want to create the Web, click Database Interface Wizard, and then click OK.

4. Leave Create a new Access database selected, and then click Next.

5. In the Enter a name for the database connection text box, type Psychology_204, and then click Next.

Note   The database connection name cannot contain any spaces.
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6. In the next window, you can modify the database form before it is created. Highlight the Address row, and then click Modify.

7. In the Column name text box, delete Address, and then type Group Presentation.

8. Leave the Column type as Text, and in the Form field input type drop-down list, select Drop-Down Box.

9. Change the number of options for the drop-down list to 3, and then click OK.
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10. Change the third form field from Choice to Rating, change the Form field input type to Drop-Down Box, and change the Number of options to 10. Click OK, and then click Next.

11. The database and the FrontPage Web are created. Click Next, and then on the next page, select the Database Editor check box. Click Next.

12. In the next window, leave the user name as Administrator, and in the Password and Confirm text boxes, type 1234. Click Finish to complete the Web.

You have now created a form by using the Database Interface Wizard. This enables students to search only the specific topics that they want in the Psychology 204 database, such as the independent variables for each study, or the specific areas in which each study was conducted.

In this example, your Psychology 204 students can modify the Submission Form they created to collect information about the various perception studies performed within given demographics. 

To modify the form you created

13. Open the Submission Form in FrontPage. 

14. Under Group Presentation, right-click the drop-down list, and then click Form Field Properties. 
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15. Select Option 1, and then click Modify.

16. Change both the Choice field and the Specify Value field from Option 1 to 1. Repeat this step for the other 2 options by changing them to 2 and 3, respectively.

17. Change the options under Rating to read 1 through 10.

18. Save the Submission Form.

To view, add, edit, or delete records by using a Web page

After you have created a form by using the Database Interface Wizard, you can access the database through a Web browser. If you have administrator permissions, you can add, edit, and delete the records. In this example, students will rate group presentations given by other students. They can rate each group, numbered 1 to 3, on a scale from 1 to 10.

19. Type the address of your Web site in the Address bar of your Web browser. The Database Interface Wizard opens.
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The three options on the main Database Interface page are: 

· Results Page. Displays results from the forms submitted to the database from the Web page. The results are listed in a table or a list so they can be compared with other fields. 

· Submission Form. Enables users to type data into the database. To modify this form, you must change it in FrontPage and then republish the Web.

· Database Editor. Enables an administrator to view, modify, and delete records.

20. Click Submission Form. 

21. In the Name field, type the student's name.

22. In the Group Presentation drop-down list, select 2.

23. In the Rating drop-down list, select 7.

24. Click OK. The record is added to the database.

To modify or delete a database record

25. In the upper right corner of the Submission Form, or on the main Database Interface page, click Database Editor.

26. In the Username text box, type Administrator, and in the Password text box, type 1234 (the password you set when you created the site), and then click Login. The Database Editor page opens.
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Note   The user name and password are case-sensitive.

27. You can now view, edit, or delete the records in the table.

· To delete a record, select the check box next to a record, and then click Delete. In the bottom frame, a message opens that confirms that you want to delete the record. Click OK to delete the record.

· To modify a record, click Record Number to open the record, click Edit, and then change the appropriate fields.

Using the Database Results Wizard

The Database Results Wizard enables you to display information from a database on a Web page. You can use the wizard to create a Web page that enables students to search for and view information from a research database. In this example, your Psychology students review statistical information about demographic studies. This example will show you how to use the Database Results Wizard to display the contents of a database on a Web site, and enable other users to access it.

To display the contents of a database on your page

28. On the Insert menu, point to Database, and then click Results. The Database Results Wizard opens.

Note   All pages that interact with a database must be saved with the .asp extension. For more information about ASP pages, see FrontPage Help.

29. Step 1 of the wizard prompts you for the name of the database to use. For this example, select Use an existing database connection, select the Psychology_204 database, and then click Next.

30. In step 2 of the wizard, specify the source of the information you want to display on your Web page, such as the name of the particular study. Make sure Record source is selected, and that Categories is visible in the drop-down list box, and then click Next. Click Next again to accept the default settings in step 3.

31. In step 4, select Drop-down list: one record per item from the drop-down list, and then click Next.

32. Click Finish to accept the default settings. The database contents are displayed on your Web page.

33. On the File menu, click Save As, and then save the page as Demographics_contents.asp.

Students can now access all of the data from the study simply by using their browsers. This increases efficiency by streamlining and organizing complex data. For example, a teacher might want to create a form for students to complete for special case scenarios, such as late or extended assignments or extra credit homework. Such a form might include fields such as the student's name and identification number, subject, and a place for comments. In the following example, you will develop a peer review form for student presentations.

To create a new form

34. On the File menu, point to New, and then click Page or Web.

35. On the New Page or Web task pane, click Blank Page.

36. On the Insert menu, point to Form, and then click Text Box.

37. Press ENTER to move the Submit/Reset buttons to a line by themselves and position the cursor to the left of the box.

38. To the left of the text box, type Your name. Position the cursor to the right of the text box, and then press ENTER.

39. Double-click the text box to open the Text Box Properties dialog box. Type name in the Name box. 

40. In the Width in characters box type 30, and then click OK. Position your cursor at the end of the question, and then press ENTER.
41. Type What type of assignment are you requesting?, and then press SHIFT+ENTER to start a new line directly under the typed text.

42. On the Insert menu, click Form, and then click Drop-Down Box. 

43. Right-click the new drop-down box, and then click Form Field Properties. 

44. In the Name text box, type AssignmentType, and then click Add.

45. In the Add Choice dialog box, type Extra Credit.

46. Repeat step 11, adding options for Late Assignment and Practice Test. Confirm that the choices are in numerical order in the list, and then click OK.

You can add as many form fields as you need to complete the form. Choose the type of form you use depending on the number, range, and type of answers you will receive.

47. On the File menu, click Save. You may want to save as you go to protect your work in progress. This is especially true in a long form.

Validating user input

Now that you have placed the questions on your survey to collect user responses, it is advisable to put in place a checking mechanism to verify that the collected data is reasonable. You may also want to block the submission of a form without certain questions being completed. You will accomplish this by using the Validate option in the Form Field Properties dialog box.

To validate data

48. Right-click the text box that prompts the user to type their name, click Form Field Properties, and then click Validate.

49. In the Drop-Down Box Validation dialog box, select the Data Required check box, and then click OK.

You can validate other types of data, such as radio buttons and check boxes, by using this method. For more information about validating data, see FrontPage Help.

Saving user input

Now that you have gathered information and validated it, you must decide where to store it. This decision depends on what you want to do with the data. You can store data, without any extra programming, in a text file, a spreadsheet, or a database. For this example, you will store the collected data in a comma separated value (CSV) file, which is a spreadsheet that contains a list of responses, with the fields separated by commas. 

To save form results to a comma separated value file

50. In FrontPage, open the page containing the form, right-click a blank area of the form, and then click Form Properties. In the Send to File name box, type the path to location where you want to save the results. The file name should end in .csv to indicate a CSV file. 

51. Click OK to save your changes and close the dialog box.

52. Choose a location in which to save the attachment(s) and click Save.

Creating a SharePoint Team Services Web site

SharePoint Team Services is a Web solution that improves the way students, faculty and educators manage information and activities. Because SharePoint Team Services is an instant Web solution, anyone can create a Web site or survey from within the browser. You can create a SharePoint Team Services Web site that serves as the central repository of school, department or class information. It can hold all class data regarding assignments, documents, contacts, tasks, and online discussions. 

You can use the document libraries within SharePoint Team Services to store information in an organized manner. For example, teachers might create a document library to store all basic forms for students, such as a course syllabus, extra credit forms, and so on. Students might create a document library in which they store all documents pertaining to a particular topic, such as Field data from a study or documents from a group project. Both students and teachers can use the SharePoint Team Services Web site to organize and share information, hold discussions, and collaborate on projects and documents. 

In addition, because of its seamless integration with Microsoft Office XP, you can add any type of Office XP document to your SharePoint Team Services Web site by using the document libraries. You can also save PDF, JPEG, HTML files, and more. For more detailed information about SharePoint Team Services, refer to http://www.microsoft.com/frontpage/sharepoint/.

SharePoint Team Services surveys 

In addition to the collaboration, file sharing, and team coordination capabilities of SharePoint Team Services, you can also use it to create surveys from within the browser. Individuals who approve new curriculum, such as Department Chairs or members of the board, can use surveys to collect data from other instructors regarding potential new courses or curriculum.  Political Science students, for example, might create a survey to poll their peers regarding political issues and candidates, and then use the data to develop a graph of their findings. 

By using an existing SharePoint Team Services Web site, you can add a survey simply by using your browser. As an alternative, you can add a SharePoint Team Services survey to an existing FrontPage Web site. For this lesson, you will use a Web browser to create a survey on a Web server running SharePoint Team Services. 

Note   To create a survey with SharePoint Team Services, you must have access to a server running SharePoint Team Services, which is included with FrontPage 2002. 

In this example, you will use SharePoint Team Services to create a survey to gather information about how much the users have traveled.

To create a SharePoint Team Services survey

53. Open Microsoft Internet Explorer. In the Address text box, type the URL of a server running SharePoint Team Services.

54. On the main SharePoint Team Services page, on the menu at the top of the window, click Create.
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55. On the Create page, click Survey.

56. In the Name text box, type the name of the survey. For this example, type Psychology 204 Survey.

57. In the Description text box, type This survey collects information about which topics students would like to cover in depth.

58. Under Display this survey on the Quick Launch bar, leave Yes selected.

59. Under Show user names in survey results, click No.

60. Under Allow multiple responses, click No, and then click Next. The Add Question page opens.

61. In the Question text box, type What do you expect to learn from this course?.
62. Under The type of answer to this question is, click Choice (menu to choose from). This changes the optional settings section to contain only options that can be used in either a drop-down list or a set of radio buttons.

63. Under Optional Settings for your Question, click Yes under Require an answer for this question.

64. In the Type each choice in a separate line text box, type 1, 2, 3, 4, 5, 6, and More than 6, with each entry on a separate line.

65. Under Display choices using, click Drop-Down Menu, and then click OK.

66. On the Customization page, verify the settings, and then click the address of your survey. 

Note  To modify existing questions or to add new questions to an existing survey, on the main SharePoint Team Services site page, click Site Settings. Under Modify Site Content, click Customize Psychology 204 Survey, and then follow the preceding procedure.

67. To test your survey, click Respond to This Survey on the menu at the top of the page, and then fill out the survey.

By using this procedure, you can easily add or remove any type of survey question, and create surveys about any topic. You have now created a SharePoint Team Services site that can be modified to be as simple or extensive as your classroom needs dictate. 

For example, you can click Show a graphical summary of responses on the main survey page to view the results of the survey in a bar graph, and you can also export the results to an Excel spreadsheet.

For more information about SharePoint Team Services Web sites, see http://www.microsoft.com/frontpage/sharepoint/.

Displaying the results of a survey

After you create a SharePoint Team Services survey, you can arrange how the results are saved. In this example, you will view the results of a survey and then export the results to a Microsoft Excel spreadsheet.

To export the results of a survey to an Excel spreadsheet

1. Go to the main survey page.

2. On the top of the page, click Export Results to a Spreadsheet.

3. In the File Download dialog box, click Save to save the file on your computer, or Open to view the results file now.

Putting it Together

Students and teachers can use FrontPage 2002 to design complicated, functional Web sites, without needing to know any Web design or programming. By utilizing the information gathering capabilities of FrontPage, such as surveys or the Database Interface Wizard, you and your students can use the power of the Web to further your classroom experience.

For more information about how FrontPage can enhance your classroom experience, be sure to see these other great FrontPage tutorials: 

Create a Course Web Site with FrontPage 2002:
http://www.microsoft.com/education/?ID=FrontPageTutorial
In and out of the classroom with Office XP:
http://www.microsoft.com/education/?ID=OfficeXPTutorial

Office XP in the Classroom:
http://www.microsoft.com/education/?ID=OfficeXPTutorialPack
For additional education tutorials on Microsoft products, see http://www.microsoft.com/education/?ID=InstructionalResources
For additional information on SharePoint Team Services and FrontPage, see the FrontPage Web site at http://www.microsoft.com/frontpage/sharepoint



Words to know:�


Browser—A program that allows you to view HTML-formatted documents. One example of a browser is Microsoft Internet Explorer.�


HTML—Hypertext Markup Language. The language used to format Web pages.





URL—Uniform Resource Locator. The name and location of a file or Web page.





Thumbnails—Small clips of digital images on your computer. FrontPage 2002 automatically builds thumbnails and lets you add captions and resize images. 
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